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New President Hits the Ground Running


I am looking forward to serving as your President for the Year 2000.  Thank you for putting your trust in me.  I will do my best to make this a productive year for Four Beats for Pleasure – of course with the help of the new Executive Board and the membership.





We have an Executive Board meeting planned for October 10.  A calendar of events will be determined and hopefully ready for the November newsletter.   Thanks for your support!  Stay tuned . . . . . .Debbie LeBlanc





New officers were elected:


Congratulations to the 1999-2000 Four Beats Officers


President:  Debbie LeBlanc


Vice-President - Athey Robinson


Treasurer - Betty Mitchell


Secretary - Kim Tyndall


Committee Chairs:


Education Coordinator - Wayne Moore


Youth Coordinator - Kevin Gilliam


4H  Coordinator - Debbie Nuding and Carol Hayes


Youth Flag Team Coordinator - Kevin Gilliam


Trail Coordinator- volunteer needed


Parliamentarian – volunteer needed


PLEASE REMEMBER THAT WE NEED A SHOW CHAIRMAN IMMEDIATELY - LET'S SEE SOME OF THE TALENT WE HAVE IN THIS CLUB PUT TO WORK HERE -


HURRICANE FLOYD RELIEF





The Executive Committee approved for Four Beats for Pleasure to donate $100 to the Hurricane Floyd Relief.  In addition, we will donate leftover 1998 Firecracker Jubilee t-shirts.  I know that many of us are also donating through companies that we work for.  These folks need so much help and Four Beats for Pleasure wanted to make some type of contribution.  Other contributions would be welcome. 








�





Four Beats for Pleasure Mission Statement





The purpose of Four Beats for Pleasure is to promote to the general public the joys of horse ownership in general and the smooth-gaited horse in particular.  Four Beats for Pleasure exists to provide a forum for smooth-gaited horse enthusiast to meet and exchange their views, to provide educational opportunities for members and the public, and to facilitate events for smooth-gaited horses to be exhibited.  Four Beats for Pleasure is designed primarily as a marketing and promotional organization for the Tennessee Walking Horse.  Four Beats for Pleasure is open to easy-gaited horse enthusiasts as a whole, without bias.  Breeds represented include, but not limited to, Tennessee Walking Horses Missouri Fox Trotters, Rocky Mountain Horses, Spotted Saddle Horses, Racking Horses, Paso Finos, and others.  In all instances, Four Beats for Pleasure recognizes the Registry representative for each breed, and encourages its members and the public to abide by the rules of those breed registries.





Visit our World Wide Web site at: � HYPERLINK http://www.homestead.com/4beats ��www.homestead.com/4beats�





SPOTLIGHT ON YOUTH


Congratulations to youth Scholarship winners Kelly Putnam and Amanda King.  The winners were announced at our Fire Cracker Jubilee in Williamston.  Kelly is attending Wake Technical College for Nursing and received a $500 award and Amanda received $200.  We are proud of both of you and a big thank you to those who submitted scholarship applications.  Thank you to the scholarship committee who worked hard to choose the winners.


Congratulations to our youth and 4-H member Alaina Parsons who won 6th place in the junior short story division at the State 4-H Horse Show in July.  Her winning story is included in this newsletter edition.  ENJOY!





Past President’s Farewell


(by Lila Blackman)


I would like to thank all the folks who took the time to come to our very important business meeting Sunday.  The bylaw changes were presented and voted on.  A copy of the amended bylaws will be included in this newsletter for every member to read and keep for reference. As this will be my last president's message, I would like to sincerely thank all of you who helped with all the tasks needed to keep this club active and alive.  I would especially like to thank Judy and Kitt Tingley for all their help with printing for us.  I would also like to thank DeDe Marshall, Sue Clements, Debbie Nuding, Debbie LeBlanc, Annette Pruitt, and Jennifer and Gary Batts, as well as Judy and Kitt, for your support and extra encouragement over these past two years in office and as show manager.  I leave you in very capable hands; we have already seen how hard Debbie LeBlanc worked as show manager, I am sure she will again give that 150% needed to steer us in the right direction.  However, remember, she needs all of our member's help.


Good bye and Thanks.


Newsletter Deadline


Our newsletter editor is Debbie Nuding.  Please note that Debbie has an email address as well as her home address.  Send all articles to her by the 25th of each month to be published in the upcoming month's newsletter.  If you have any news let her know - ads are welcome also.  Email address is � HYPERLINK mailto:debbie.nuding@ncmail.net ��debbie.nuding@ncmail.net�.  Home address is:  5256 Pearces Road, Zebulon, NC  27597.  If you have pictures you want to include in the newsletter, we will try them to see how they work within the newsletter.  Scan and email them as gifs or send them through US mail.  Keep the size to a minimum.


How to Reach your NEW EXECUTIVE BOARD –2000





President – Debbie LeBlanc – (919) 207-0872 or work (919) 483-2854 (djl25582@glaxowellcome.com)


Vice President – Athy Robinson – (919) 528-9035 or work (919) 684-6303 (Athyrobi@Duke.edu)


Secretary – Kim Tyndall (919) 483-8347 (kmt42711@glaxowellcome.com)


Treasurer – Betty Mitchell – (919) 553-7948


Newsletter Editor – Debbie Nuding – (919) 269-2132 or work (919) 981-5312 (debbie.nuding@ncmail.net)


Youth Director – Kevin Gilliam – (919) 693-4789 (bayfield@gloryroad.net)


Educational Director – Wayne Moore – (919) 693-4789


FALL FUN SHOW





A fall fun show is planned for Saturday, November 13, 1999.  Mark your calendar and look for details in your mail the middle of October.  A great way to acquire those needed versatility points!


Farm News


News From Starwalker Farm





We recently returned from our first trip to the Tennessee Walking Horse National Celebration.  The 1998 Youth Superior Champions were recognized in center ring ceremonies on September 2.  We had a great trip and enjoyed touring the many shops and farms Shelbyville and Murfreesboro has to offer.  Yoda has been getting a well-deserved rest, but she will have to come out of retirement soon to attend the fall fun shows on the calendar.  We extend our thoughts and prayers to all of our fellow horsemen in the eastern part of our state.  They have a long way to go to recover from the floods of Hurricane Floyd. 


Submitted by Debbie Nuding &  Emily Kaczynski








Attention Four Beats Members!!!!


WANTED - Show Manager and Show Secretary for Y2K Firecracker Jubilee.  If you are interested, please contact Debbie LeBlanc as soon as possible (919) 207-0872 or (919) 483-2854. 


We need to get started quickly.  The show will take place again in Williamston. 





News from Caballera Farm:


Happy Birthday to Alaina Parsons (Sept) and Samantha Daigneault (Oct)!


Both of these girls have been working their horses really hard.  Samantha will be showing her new horse "Rock" for the first time at the State Fair. We wish her and Rock a lot of success and fun.  Alaina is still waiting for her "birthday" beach horseback ride - seems as though Dennis and Floyd want to see just how patient Alaina can be.  Hang in there Alaina, we will get there yet to celebrate- oh well - nobody said it would be "THIS" birthday. I know that isn't funny). Eric Goswick has been working on cantering Acid and is doing a great job. And speaking of Floyd, I have been trying to breed a mare since April and wouldn't you know it, she is finally ready and the rains set in.   But, thanks to Kevin not wanting to get soaked by the pelting rains (I have been chicken to breed the guys myself - so Kevin has always had to come over and do my job for me), I finally got the guts to handle Gryphon myself and hopefully Gryphon will have another foal on the ground next year. (Sassie and Linda Powell are expecting a Gryphon foal very soon too).   It's funny how things work out, a bad situation actually became a great day for me – I learned that I CAN handle Gryphon quite well in spite of myself.  That "bad" situation gave me the confidence I have needed all along with him.    I was so happy and proud of myself as well as Grypon that I took him on a trail ride to reward him and myself the following weekend. Brittany Tyndall and I went on a "Hunter Pace" at Killcastle in Apex Sunday.  The trails and the weather were great.  And to top it all off, Brittany on Luke and I on Acid took 2nd place in our division.  THANKS BRITTANY FOR BEING SUCH A GOOD PARTNER.  Acid and Luke gait very well together – we clipped along at a right good pace.  Now what I wonder is - do we need to speed up or slow down to get a shot at first place? Till next month—Lila








he If you want to change the color or borders on a text box, choose the Colors and Lines tab. To change the size, scale, or rotation, click the Size tab. To change the position of the text box on the page, click the Position Tab.  If you have other text surrounding the text box, and want to change the way the text wraps around it, click the Wrapping tab. If you want to format all the text boxes in an article, you must format them individually - the formatting on one text box will not apply to the others in the sequence. 


Using Linked Text for Parallel Articles


You can use linked text boxes to flow text in parallel  “columns” from page to page. This method gives different results than using the Column command on the Format menu, which causes text in column 1 to flow or “snake” to column 2 on the same page. By using linked text boxes, you can instead have text from column 1 flow to column 1 on the next page. The text beside it in column 2 can flow to column 2 on the next page, parallel to column 1. This technique is useful if you need to group two similar articles, for instance, an article translated in English on the left and the same article translated in French on the right. 


To flow text in parallel, display paragraph marks in your document. Click at the top of the page where you want the side-by-side columns to start, and press Enter twice. Click in the first paragraph mark on the page. On the Insert menu, click Text Box and drag on the page where you want the first column. Click Text Box again and then click and drag where you want the second column. Click in the last paragraph mark on the page, and press Ctrl + Enter to create a page break.


Repeat the process for each page that will contain side-by-side columns in your document and then return to the first text box you created. Click the text box on the left once to select it. Click your right mouse button and then click Create Text Box Link. The pointer becomes a pitcher. Click the text box on the left side of the second page to create a link. Create links for all text boxes within the same article on the left side of the document. Repeat the process for every text box in the right chain or article.


Pressing Enter twice at the top of each page will create an extra empty paragraph. This blank paragraph is useful if you want to insert text or graphics outside of the text boxes. You can delete the extra blank paragraph if you don't need it.


Copying linked text boxes


You can copy an article or a chain of text boxes that are linked together, to another document or to another location in the same document. To copy linked text boxes and the text they contain, you must copy all the linked text boxes in an article. Select the first text box in an article. Hold down Shift, and click each additional text boxes you want to copy. On the Edit menu, click Copy. Click where you want to copy the text boxes and then click Paste.


To copy some of the text from  an article, select the text you want to copy from the article and then copy it. Do not select the text box. You can paste text you’ve copied directly into your document, into another location within the same article, or into another article.


Notes on Linked Text Boxes


The text boxes that you link to must be empty—they cannot contain text.


Linked text boxes must be contained in a single document. You cannot create text box links from one subdocument within a master document to another subdocument. You also cannot split subdocuments that contain linked text boxes belonging to the same article.


If you click Create Text Box Link and then decide you don’t want to link to another text box, press Esc to cancel.


To move between text boxes in an article, select one of the text boxes and then click either the Next Text Box or Previous Text Box on the Text Box Toolbar. (





FOR SALE





Whitman 21" deep seat cutback show saddle. Outstanding condition. $450 without fittings, $500 with.


Contact Margie Rhodes at 919.772.8298, or email � HYPERLINK mailto:walkabout@intrex.net ��walkabout@intrex.net� 





Barrett 6 horse aluminum custom stock slant load trailer. 24' box.  Collapsible, removable saddle compartment, small dressing room, padded, cushioned slant dividers. Mats on floor and walls. Well-maintained, very good


condition. $12,000 negotiable.  Contact Margie Rhodes at 919.772.8298, or email � HYPERLINK mailto:walkabout@intrex.net ��walkabout@intrex.net� 





Wanted To Buy:


Living quarters aluminum gooseneck trailer. Two or three horse. Prefer Sundowner, but will consider any brand.


Contact Margie Rhodes at 919.772.8298, or email � HYPERLINK mailto:walkabout@intrex.net ��walkabout@intrex.net�


AT STUD:  “SLIM JIM”             SSH/TWH Stallion - $250


Sorrel Tobiano – 15.3 hands.  Outstanding confirmation, gentle and very well mannered.  Prides Gold Coin, Prides Royal Master and Mark of Carbon breeding.


1999 Mississippi SSH Spring Show - 3 Yr. Old Open Champion


1999 Firecracker SSH Model Champion


Contact:  Debbie LeBlanc (919) 207-0872 or (919) 483-2854





FREE to GOOD, LOVING Home:


2 cute kittens, one is black with blue eyes, the other a loving calico.  Please call Emily Kaczynski at (919) 269-2132 if you are interested in adopting them.
































calendar of Events


OCTOBER 3, 1999


4 Beats 4-H Meeting/Tour/Cookout  2:00pm-6:00pm


Contact Debbie Nuding (919) 269-2132





OCTOBER 10, 1999


Executive Board Meeting, 3:00pm-5:00pm


Contact Debbie LeBlanc (919) 207-0872





OCTOBER 15-17, 1999


State Fair Youth Day and Walking Horse Show


Call (919) 733-4845 for more details





OCTOBER 16, 1999


Palmetto Pleasure Horse Show, Clemson, NC


Contact (706) 868-9946 for more details





OCTOBER 30, 1999


PPWHANC Fall Fun Show


Contact Barbara Curtis (919) 303-1743


Rain date is OCTOBER 31, 1999.





NOVEMBER 13, 1999


Tentative date for 4 Beats for Pleasure Fall Fun Show


Contact Debbie LeBlanc for more details (919) 207-0872








If you know of horse shows, trail rides or other activities which would be of interest to our club, please send them to Debbie Nuding, 5256 Pearces Road, Zebulon, NC  27597 or call (919) 269-2132.








SPOTLIGHT ON 4-H








The Four Beats for Pleasure 4-H Club is proud to be a part of the Disaster Relief efforts for the Hurricane Floyd victims.  The club donated $50 of personal care and cleaning items to assist those who need the help so desperately.  The 4-H Club and Youth Group would like to thank Dr. Karen Bullock of Snow Hill for taking the time to answer our questions and inform us about "founder."  We were also provided with a wonderful hotdog cookout and Paso Fino demonstration while we were there.





4-H MEMBERS


We have a meeting and field trip planned for October 3, 1999.  Please meet at my house by 2:00pm.  We will be traveling to the NC Equine Rescue League farm in Youngsville for a tour of their facility and then back to my house for a brief meeting and cookout.  Bring your project books!  Please call and let me know if you can come.


DIRECTIONS:  Take Hwy. 64 East to the Zebulon/Oxford Hwy.96 exit.  At the exit ramp stop sign, turn left and cross over Hwy 64.  At the DashN/Zebulon Animal Hospital, turn right onto Pearces Road.  We are about 7 miles down on the right.  You will pass the Zebulon Country Club and Golf Course and Pearces Baptist Church.  We are about 1 mile from Pearces Baptist Church on the right.  Look for the StarWalker Farm sign in the front yard as well as a gray, 2-story house.  The street address is 5256 Pearces Road, Phone:  269-2132.





Hurricane Floyd Information and Disaster Relief





Many of you have asked about how to help the pet victims of the hurricane. The United States Humane Society is responsible for coordinating the rescue efforts for all animals until Wednesday, September 29, 1999.   Betty Simms is the coordinator.  She may be reached at (919) 715-9679 or (919) 881-9800.  If you have access to the internet, there is a lot of useful information on the web site � HYPERLINK http://www.cals.ncsu.edu/an_sci/extension/horse/hurrevac.htm ��http://www.cals.ncsu.edu/an_sci/extension/horse/hurrevac.htm�.  It includes how to prepare your farm for a hurricane and what to do after it’s all over.  If you do not have access to the internet, call (919) 515-5784 for more information.








ALWAYS WITH YOU





	The April sun feels warm as it rises over the trees.  I’m leaning on the railing of the ring watching a black and white body canter in circles.  This creature is a beautiful Spotted Saddle Horse colt who’s only three years old.  His name is Fancy’s Tuxedo, but we call him ‘Tux’.  Tux has a shiny, black body with four white stockings and a long, white mane and tail.  The last thing to add t this colt is a straight, wide blaze running down the center of his intelligent face.


	Jane McSouthern, his owner, is lunging him.  This will be Tux’s last week here.  On Saturday Jane’s sending him to a trainer.  Everyone here will miss him, especially Jane and me.


	“Whoa! Easy boy!” Jane calls, trying to stop Tux.  He ignores her when he sees me at the rail.  He pulls away and trots over.


	“Hey beautiful,” I say as I stroke his blaze.  “How’s he doing?”


	“Magnificent,” Jane replies.  “But it’s not going to be the same around here without him.”


	“That’s for sure.  Want me to cool him out?”


	“Sure.  I’ve got to go,” Jane answers as she walks away.


	I walk Tux underneath the trees before leading him towards the stable.  Tux stands quietly while I brush his coat until it gleams.


	“I wish you weren’t leaving!  I’ll miss you so much!”  I bury my face in his mane before turning him loose in the pasture.  “Oh well.  It’s for the best.”  I watch as he gallops up the hill to join the other horses.  Then I realize just how much I’ll miss him.  With this thought in my mind, I go about my other chores.





	Saturday dawns clear and bright.  Tux’s coat shines as I cover him with a sheet.  Then Jane leads him into the trailer and closes the door.


	“Good-bye Tux, be a good boy,” she says as she hugs him.


	“Bye Tux, I’ll miss you!  I love you,” I whisper in his ear as I give him a kiss goodbye.  We watch as the horse trailer rolls down the road and out of sight.  The small crowd gradually leaves, but Jane and I continue to stand thinking about what it’ll be like around the stables without Tux.  After a while I remember my chores.


	“I have to exercise Zoe,” I call over my shoulder as I head towards the barn.  Zoe is my favorite horse at Sunset Stables, but not because I own her.  I love her personality.  She’s a black Tennessee Walking Horse.  As I tack her up I tell her about Tux and by the time I mount up, I have tears in my eyes.





	My alarm clock rings at 4:00 AM.  I get dressed and hurry outside.  Two weeks from today Tux will be coming home!  I do my chores and rush to the barn office.


	“Hey Linda, have you seen Jane?”  I ask the barn manager.


	“She just left a minute ago.  She said she got a call from Tux’s trainer.  He needed her to come over, but he didn’t say why,” Linda answers.


	“Maybe Tux is coming home early!” I squealed.


	“Maybe,” but Linda looked doubtful.





	Jane didn’t return that day.  We were starting to worry, but our worries disappeared the next day when Jane’s car pulled into the parking lot.  Her eyes were full of tears.  I knew right away that something was wrong.


	“Allie, I need to talk to you,” were the first words that came out of her mouth.  We went into the barn office and sat down.


	“Jane, what’s wrong?” my words came out gently, but demanding.


	Jane took a deep breath and started her story.  “Yesterday, Phillip the trainer, took Tux on a trail ride.  He was riding along the side of a road when he heard a car coming.  The car didn’t slow down to pass them. So Phillip backed Tux into a ditch.  Tux’s front hoof landed on a glass bottle, shattering it.  Phillip didn’t hear the bottle break and when Tux was almost out of the ditch his back hoof slipped and his tendon landed in the broken glass!  The tendon was ripped apart.  Phillip wrapped his belt tightly around the leg to stop the bleeding, and then he hitched a ride to the stables and came back to get Tux.  When they got Tux to a vet, he said that they could save him, but Tux would always be in pain.”





	“So that’s why he called you,” I interrupted.


	“Yes, to make the decision.  I,…….I decided to……..to put him down!,” Jane broke out in sobs.


	“You did the right thing.”


	“Here, I have something for you,” Jane reached into her purse and pulled out a braided piece of Tux’s mane.


	“Oh, Jane,” I sobbed, “I can’t accept this!  You need this more than I do!”


	“I have one,” Jane was trying to contain her sadness, but it wasn’t working.  We both started to cry and hugged each other.  I was trying hard not to cry because I knew it would upset Jane more.  As soon as we were through, I ran to the barn.  I put Zoe’s bridle on her as fast as I could and leaped onto her back.  I leaned forward on her neck as I galloped her up to the top of a hill that overlooks the farm.  When we reached the top, I jumped off Zoe, buried my face in her mane, and cried.





It’s now been two years since Tuxedo’s death.  We still miss him, but life goes on.  But on special days when the weather is just right and the wind is blowing, I smile when I hear a soft whinny, and a voice whispers “Don’t cry for me, I’m always with you.”





Written by Alaina Parsons





Debbie Nuding


5256 Pearces Road


Zebulon, NC  27597
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